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Chapter 1. Release Notes
Contains information about new features, defect fixes, and known issues in Unica Campaign 

and Optimize that HCL releases as part of a scheduled software release.

Unica Campaign  12.0 system requirements and 
compatibility
Unica Campaign  is part of the Unica  suite of products. Unica Campaign  version 12.0 

requires Unica Platform  12.0.

Where to find complete system requirement and compatibility information

For a list of Unica  product versions compatible with this product and a list of third-party 

requirements for this product, see the Recommended Software Environments and Minimum 

System Requirements  document. ).

You can also access this document by selecting Help > Product documentation  when you 

are logged in to Unica.

Prerequisites for using Unica Campaign
Before you begin using Unica Campaign, confirm that your environment meets the following 

requirements.

• For an improved user experience, use at least a 21" screen.

• For an improved user experience, set your screen resolution to 1600 x 900. Lower 

resolutions can result in some information not being properly displayed. If you use a 

lower resolution, maximize the browser window to see more content.

• A mouse is best for navigating in the user interface.

• Do not use the browser controls to navigate. For example, avoid using the Back and 

Forward buttons. Instead, use the controls that are in the user interface.

• If pop-up blocker (ad blocker) software is installed on the client machine,  Unica 

Campaign  might not function properly. For best results, disable pop-up blocker 

software while running Unica Campaign.
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• Ensure that the technical environment meets the minimum system requirements and 

the supported platforms.*

• The correct browser and versions must be used.*

• Clear the browser cache after upgrading or applying any fix pack. This only needs to 

be done once, after the application is updated.

• If you use Internet Explorer (IE) with Unica Campaign  or any module that uses 

Unica Campaign  flowcharts (IBM eMessage, Unica Optimize, Unica Interact, Unica 

Collaborate): To log in multiple times to view side-by-side information, open IE and log 

in to Unica. Then select File  > New Session  in the IE menu bar. In the new IE browser 

window, log in to Unica  as the same or a different user.

Important:  Do not use any other method to open multiple sessions. For 

example, do not open a new tab; do not open another browser session from 

the Start  menu or desktop icon; and do not use File > New Window  in IE. 

These methods can corrupt information that is shown in the application.

*For details on the items indicated by an asterisk, see the Unica  Recommended Software 

Environments and Minimum System Requirements.

Unica Campaign  documentation roadmap
Unica Campaign  provides documentation and help for users, administrators, and 

developers.

Table  1. Get up and running

Task Documentation

Find out about new features, known 

issues, and limitations

Unica Campaign Release Notes

Learn about the structure of the Unica 

Campaign  system tables

Unica Campaign System Tables and Data Dictio

nary

Install or upgrade Unica Campaign One of the following guides:
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Table  1. Get up and running  (continued)

Task Documentation

• Unica Campaign Installation Guide

• Unica Campaign Upgrade Guide

BIRT Reports for Unica Campaign BIRT Installation and Configuration Guide

Implement the IBM Cognos®  reports 

provided with Unica Campaign

Unica Reports Installation and Configuration Guide

Table  2. Configure and use Unica Campaign

Task Documentation

• Adjust configuration and securi

ty settings

• Prepare Unica Campaign  for 

users

• Run utilities and perform main

tenance

• Learn about integrations

Unica Campaign Administrator's Guide

• Create and deploy marketing 

campaigns

• Analyze campaign results

Unica Campaign User's Guide

Improve flowchart performance Unica Campaign Tuning Guide

Use Unica Campaign  functions Macros for HCL Unica

Table  3. Integrate Unica Campaign  with other HCL products

Task Documentation

Integrate with IBM Engage Campaign and Engage Integration Guide for IBM 

Marketing Cloud
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Table  3. Integrate Unica Campaign  with other HCL products  (continued)

Task Documentation

Integrate with IBM Digital Analytics Unica Campaign  Administrator's Guide: How to 

configure the integration

Unica Campaign  User's Guide: Targeting IBM Digi

tal Analytics segments in campaigns

Integrate with Unica Plan Unica Plan and Unica Campaign Integration Guide

Integrate with  Opportunity Detect Unica Campaign  Administrator's Guide: How to 

configure the integration

Opportunity Detect  Administrator's Guide  and Op

portunity Detect  User's Guide: How to administer 

and use the product

Integrate with IBM eMessage Unica Campaign  Installation and Upgrade guides: 

How to install and prepare eMessage components 

in the local environment.

IBM eMessage  Startup and Administrator's Guide: 

How to connect to the hosted messaging re

sources.

Unica Campaign  Administrator's Guide: How to 

configure offer integration.

Integrate with IBM SPSS Modeler Ad

vantage Enterprise Marketing Man

agement Edition

Unica Campaign  and IBM SPSS Modeler Advan

tage Enterprise Marketing Management Edition  In

tegration Guide

Integrate with IBM WeatherFX. You can integrate WeatherFX with Campaign so 

that you can pull weather events into your market

ing campaigns. Unica Campaign version 9 and ver

sion 10 users can integrate with WeatherFX by us

ing the UBX toolkit.
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Table  3. Integrate Unica Campaign  with other HCL products  (continued)

Task Documentation

Integrate with  Unica Director. Unica Director Installation Guide: You can inte

grate  Unica Director with  Campaign so that you 

can get status of all the running/completed/failed 

flowcharts, migrate Camapigns from one Unica 

Campaign  environment to other, download/delete 

flowchart logs etc.

Note:  Additional integrations may be available that are not listed in this table. See 

Product tools and utilities for Unica Campaign.

Table  4. Develop for Unica Campaign

Task Documentation

Use the REST API See the Unica Campaign REST API

Use the SOAP API • See the Unica Campaign SOAP API Specifi

cation

• JavaDocs in devkits\CampaignSer

vicesAPI

Develop Java™ plug-ins or com

mand-line executables to add valida

tion to Unica Campaign

• See the Unica Campaign Validation PDK 

Guide

• Java-docs in devkits\validation

Table  5. Get help

Task Instructions

Open online help When using the Unica Campaign  application:

https://www-947.ibm.com/support/entry/myportal/clientsidetools/enterprise_marketing_management/ibm_campaign?productContext=-198760082
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Table  5. Get help  (continued)

Task Instructions

1. Choose Help > Help for this page  to open a 

context-sensitive help topic.

2. Click the Show navigation  icon in the help 

window to display the full help.

You must have web access to view context-sensi

tive online help. Contact  Support for more infor

mation about accessing and installing  Knowledge 

Center locally for offline documentation.

Get PDFs When using the Unica Campaign  application:

• Choose Help > Product documentation  to 

access Unica Campaign  PDFs.

• Choose Help > All Unica  documentation  to 

access all product PDFs.

• Click the links for PDFs during the installa

tion process.

New features and changes in version 12.0
Unica Campaign  12.0 includes a number of new features and changes. These are listed 

underneath.

For a list of newly supported and discontinued platforms, see the Recommended Software 

Environments and Minimum System Requirements guide.

Upgrade Paths

• Supported upgrade path via installers: 11.1 -> 12.0 only.

• Customers prior to 11.1 must perform Fast upgrade to 12.0.
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Fast Upgrade

Unica Campaign  12.0 supports the fast upgrade approach. This approach allows upgrades 

from version 8.6 onwards to version 12.0. This helps customers bypassing the multi-step 

upgrade. The Fast Upgrade approach is also useful in reducing upgrade downtime. The 

approach is provided for  Unica Platform,  Campaign,  Optimize,  Plan,  Interact for upgrade 

from 8.6.x version onwards. For details, see the Fast Upgrade documentation released with 

version 12.0.

New third party softwares supported

See the Recommended Software Environments and Minimum System Requirements guide 

for more details.

Databases:

• Oracle 19.3 - Unica Campaign now supports Oracle 19 System and User database.

• Maria DB 10.4.x - Unica Campaign now supports Maria DB System and User database.

• SQL server 2019 - Unica Campaign now supports SQL server 2019 System and User 

database.

• DB2 11.5 - Unica Campaign now supports DB2 11.5 System and User database.

Campaign and Optimize – replace GSKIT with OpenSSL
IBM Campaign GSKIT cryptography support for SSL is now replaced with OpenSSL. To 

configure OpenSSL certificates, please follow the instructions in the Unica Platform 

Administrator's Guide. The high-level steps are summarized below:

1. Generate Campaign certificates using OpenSSL and configure settings in 

CAMPAIGN_HOME/conf/config.XML.

2. Generate JAVA certificates.

3. Exchange OpenSSL certificates with JAVA certificates.

4. Configure SSL certificates in the WebSphere®, WebLogic, Tomcat or JBOSS 

application server.



Unica Campaign V12.0 Release Notes  | 1 - Release Notes  | 8

Note:  For upgrades: Existing customers with GSKIT SSL environments must remove 

the SSL certificates and configure new certificates using OpenSSL. Existing SSL 

certificates will not work. For instructions, see the " Implementation of one-way SSL” 

section in Unica Platform Administrator's Guide

Campaign flowchart execution Email Notifications

Unica Campaign can now send email notifications to user's on-flowchart execution 

statuses.

Email notifications are send to the flowchart executor users' configured email address. If 

you execute flowchart using schedule process box, then the flowchart execution will still 

get emails. For flowchart runs which are scheduled using Platform scheduler, flowchart 

execution status emails will be sent to flowchart creator. The following execution statuses 

are notified to the flowchart executor user through email notification:

• Flowchart Run

• Flowchart Finish (Ran Successfully)

• Flowchart Stop

• Flowchart Pause

• Flowchart Continue

• Flowchart Failure

Campaign REST API Support for Campaign objects like Campaigns, Session, 
Flowcharts, Process boxes, and swagger documentation

Campaign application has opened up APIs through REST, which can be used in any third-

party application. Before using these APIs in any third-party tools users must generate 

the authentication token using the following Platform API. Its recommended that Unica 

Platform users consume these APIs.

For more details on the swagger documentation, see the Unica application Campaign 

Settings page > API Documentation.

With Campaign 12.0 release, the following Campaign components REST APIs are made 

available:
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• Attributes

• Campaigns

• Flowcharts

• Segments

• Sessions

• Flowchart process boxes – (Select, Segment, Merge, Extract, CreateSeg, Mailist) ** 

Process box API support is with basic configurations.

On Swagger documentation, page authentication steps are not required as the user is 

already logged in Unica application:

PLATFORM AUTH_API with POST method -http://{host:port}/unica/api/manager/

authentication/login

Request header

m_user_name:{platform_user_name} 

m_user_password:{platform_password} 

RESPONSE- Above API will return token which should be used in subsequent 

 APIs 

Eg: CAMPAIGN_API : 

 http://{host:port}/Campaign/api/campaign/rest/v3/campaigns/search 

Request Header for Subsequent APIs: 

m_user_name: {platform_user_name} 

m_tokenId: {platform_token_id} 

api_auth_mode: manager 

Content-Type:application/json 

Campaign and Optimize seamless integration

Unica 12.0 release comes up with seamless integration of Unica Campaign and Unica 

Optimize. Unica Optimize session management, execution, and clustering capabilities are 

introduced with v12.0. Prior to v12.0 Campaign administrators were required to switch from 

Optimize to Campaign several times. Campaign users were required to design Optimize 

session, come to Campaign flowchart and design a pre-optimization flowchart, navigate 
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back to Optimize and execute the Optimize session. Design or navigate to post-optimization 

flowchart and run the flowchart. Unica Campaign and Unica Optimize seamless integration 

will help the users with session management, seamless execution, and clustering support to 

Optimize session execution.

Unica Optimize Session management using Campaign flowchart

Flowchart designer would be able to create, edit, copy Optimize sessions in Campaign 

flowchart Optimize process box. Optimize process box will have the capability to create new 

optimize session, add or edit optimization rules in the newly created session. Users can 

also edit the existing session and update the rules in it. User can also create a copy of the 

existing session along with rules in Optimize process box. While selecting Optimize session 

users can search for the sessions and assign in Optimize process box.

Optimize sessions created or edited from Optimize process box will be available on the 

legacy Optimize Session listing as well. There is no change in the existing Optimize session 

listing page capabilities.

Unica Optimize Session management Seamless execution

In Campaign flowchart – Optimize process box, a new option is provided “Yes! I want to 

run this session now”. Flowchart designer can select the checkbox to execute the Optimize 

Session along with Optimize session execution. This will help Campaign designers to merge 

Optimize pre-optimization and post-optimization flowcharts in single flowchart execution. 

Users are not required to keep a watch or write any script to run Optimize session after the 

completion of its respective process-box run.

There is no change in the existing flowchart designs or optimize session executions.

Clustering support to Unica Optimize Session execution:

Optimize session execution is not supported with clustering capabilities using Campaign 

listener. By implementing the back-end Campaign Analytics server on multiple physical 

machines, you allow for automatic load balancing of Optimize session execution using 

a round robin approach based on administrator-defined values for priority and weight. 

Campaign listener is now having “listenerType” configuration, which decides whether it 

will execute Campaign flowcharts, Optimize Session or both. Based on the ListenerType 

configuration value, Campaign Listener will pick up the execution requests. Prior to v12.0, 
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all Optimize session execution happened on the single machine. With Optimize listener 

installation and with clustering support Optimize session execution will now happen on 

cluster listeners with “listenerType” as “Run Optimize Session” or with ListenerType as “Run 

Campaign flowchart and Optimize session both”.

This will eventually enable the users to run more Optimize sessions and reduce the 

execution time.

Existing Campaign listener clustering capabilities are used for Optimize sessions. This 

would not require any new cluster configurations. Existing Campaign listener configurations 

would serve both Campaign and Optimize session clustering support.

For information about listener clustering, see the following documents:

• Unica Campaign Installation Guide -or- Unica Campaign Upgrade Guide

• Unica Campaign Administrator's Guide

Campaign installer capabilities to install Optimize

Unica Campaign 12.0 installer now installs and enables Optimize along with Campaign. 

Campaign installer will execute the Optimize database SQL scripts and perform the 

Optimize registration. Users are not required to run a separate installer for Optimize.

Note:  From v12.0, to execute Optimize sessions users are required to apply for 

Licenses. Please get in touch with HCL Support or Sales team for more details.

Centralized Offer Management

Starting from v12.0, Unica is introducing a new product called as Centralized Offer 

Management. This product can be used as a central place for Offer Management. If you 

are planning to configure Centralized Offer Management, please see the Centralized Offer 

Management installation guide for more details.

Centralized Offer Management product is an additional component to start managing 

offers available in the Campaign Offer management. If you do not have Centralized Offer 

Management module installed or enabled, then Campaign Offer management will continue 

working as it is.
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Once you install and enable Centralized Offer management, all offers information including 

(templates, attributes, offer folders, offers, offer lists) would become available in the 

Centralized Offer management. Centralized Offer management module can be turned ON 

and OFF based on configuration. This will not impact any offers data whether its created in 

Campaign Offers or in Centralized Offers Management module.

Out of the Box Reports with BIRT reporting tool

Campaign now supports BIRT as a reporting tool for reporting purposes. BIRT reporting tool 

would be by default bundled and available with Unica Platform. Campaign provides all out 

of the box support with BIRT reporting tool for system databases, such as SQL, ORA and 

DB2. BIRT or IBM Cognos reporting support would not be available for system tables such 

as MariaDB. This will not require users to purchase new licenses of IBM Cognos. Users 

would be able to use either BIRT reporting tool or Cognos, but not both at the same time.

Fixed defects in Unica Campaign  and Optimize 12.0
The following defects were fixed in Unica Campaign  12.0.

Issue key Summary

HMA-275481 Flowchart failed to run when when a "=" character is contained within 

the name of a flowchart.

HMA-302471 Customers were unable to use the "size" and "modified" sort tabs in 

the mail list process box when pasting any template. Once the tabs are 

clicked, the arrows on the tabs remain grayed out and are unable to 

sort

HMA-277141 If SSL was enabled post installation, then campaign web services URL 

was not accessible.

HMA-294598 In Optimize, incorrect column name appears on UI with Google Chrome 

for Optimize session > Score matrix
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HMA-302416 Segment List UI distorted on accessing Displayed Segments >> Search 

Tab >> Tree View.

HMA-286185 Security Vulnerability: Sensitive information like username was ex

posed in the URL.

HMA-302476 Folders were arranged in the descending order by default under cam

paign-> campaigns folder .

HMA-302405 After changing the value of "progressFetchDelay" under Affinium|Cam

paign|partitions|partition1|Optimize|sessionRunMonitor from default 

value of 250 ms to a value like 2500 ms, incorrect run status of Opti

mize session was observed.

HMA-285636 A flat file with blank records in it did not throw error for an Extract 

process box.

HMA-293723 Users were not allowed to create offers when Campaign web app is in

stalled separately than Campaign listener component.

HMA-291171 Load balance was unequal in spite of equal LoadBalanceWeight set for 

each listener nodes in a listener clustered environment.

HMA-290905 When fields were mapped to a mapped table in Snapshot process box, 

not all fields were displaying in the Snapshot process box.

HMA-284088 Additional double quotes around user variables that have space(s) in 

between the string caused triggers to not parse the string correctly.

HMA-292995 After upgrading to version 11.1, when System Database was SQL serv

er, UBX data was not inserted into UA_EMAIL* tables.

HMA-283430 Optimize session failed in actual, but Platform scheduler showed run 

state as "successful".

APAR 

PO07157, 

DEF 266689

A linked campaign in Plan allowed the unsupported characters Back

slash (\) and double quotes (") in its name.
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APAR 

PO07143, 

DEF 266014

The Campaign permissions did not work as per design for flowchart 

objects when the permission is state is 'Not Granted'.

HMA-302421 BM Campaign extract process did not write to DB2 database when 

flowchart was configured with two extract processes and the second 

extract process contained a derived field that uses French accented 

characters in the name of the derived field.

HMA-289540 Segments displayed in a confusing manner if same segment was used 

in multiple flowcharts.

HMA-267944 Redundant queries displayed on opening the flowchart.

HMA-288804 unica_acsvr ghost process ran uselessly.

HMA-244840 When Campaign ran a query of "INSERT INTO... SELECT FROM ..." and 

joined base table, temporary table and extract table, the 'SuffixOn

InsertSQL' value was inserted twice which was breaking the query and 

generating an error.

HMA-304483 Unable to edit 'Over the time period' column of FEC rule

HMA-280262 Session file size was increasing while saving the flowchart.

HMA-284692 While creating campaign, giving dates greater than 2020 in effective/ 

expiration date, resulted in bad date.

HMA-293646 The check box 'Do not run subsequent processes for empty cells' 

apeared as unchecked on reopening of page, even when user had 

checked the box and saved it.

HMA-185759 For nested Segment processes that used a de-normalized table, the 

condition whichis used for "Use Query Scope from Input Cell" is not ap

plied for processing records in subsequent process boxes.

HMA-303657 Under a specific scenario, segment crashed when running.

HMA-293082 Multi-threaded UBX download ETL consuming system resources.
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HMA-288413 Disable medium strength SSL ciphers supported by Contact Optimiza

tion

HMA-288562 Medium strength ciphers/protocols for Unica Campaign and Optimize 

Listener were disabled.

HMA-286064 Events were not getting downloaded and showed error

"org.hibernate.MappingException: org.hibernate.dialect.

Oracle9iDialect did not support identity key generation" in UBX log.

HMA-302744 Duplicate Interact segments displayed in the segment listing page

HMA-282906 Files created by Campaign (for example; Temp file or snap shot output 

file) were created in the root group instead of the user group that was 

specified in an alternate login.

HMA-162581 An error occurred when users tried to read the log files on GUI on a 

Clustered Campaign env, from the Settings > Camapign Settings > View 

System Log option

HMA-298393 While scheduling a flowchart with Platform scheduler if the data 

source credentials were supplied at scheduler page (in case ASMSave

DBAuthentication was set to FALSE for this data source) then the flow

chart failed with error.

CODE 11522: Invalid database connection (user was not logged 

in to DB)

HMA-302463 GDPR : Incorrect Delete table UA_EmailOptOut in script for v10.1.0.3

HMA-302454 The delete, used against the UA_TREATMENT, was not correct when 

there was more than 1 audience .

HMA-302351 GDPR: Incorrect script in case of composite audience - Integrity con

straint violated

HMA-292390 SQL on connect caused failure on Oracle 12.x.
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HMA-302871 Crashed with 10404 error, when importing flowchart template with 

ICGF in French locale

HMA-285576 When user gave "\" in the subject line for Email process, Email Process 

Box run failed.

HMA-302499 Optimize functionality broke - POST OPT EXTRACT is picking whole 

list.

HMA-288829 When text type mailing template was used in Email process box then 

text was missing in the received mail.

HMA-288565 In the Email Box - when user added Ampersand in Subject Line, after re-

running the process additional symbols in the email subject line were 

added.

HMA-288597 In Windows environment user received "failed to receive status" re

sponse from listener nodes.

HMA-285653 Version - Hive SQL Generating Issue

APAR 

PO06266, 

DEF 224540

When different users accessed different flowcharts at the same time, 

in some environments, irrelevant flowcharts were displayed in a Cam

paign.

If this issue does not occur in your environment, set the following para

meters in JVM to reverse this fix.

HMA-303656 Changes not replicating in audience process box

HMA-304838 All contact history deleted after disabling log to contact history and re

run of mail list failed with an error.

HMA-302456 Incorrect value displayed on summery pane of Campaign Custom at

tribute in case of decimal digits.

HMA-302399 An error occurred when maximum number of expressions in a list was 

1000 and Campaign had more than 1000 offers associated with it on 

the Summary Tab.
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HMA-294571 An error occurred when the rows were selected in the target cell 

spreadsheet and were moved up and down.

HMA-292987 Users were unable to connect to the Oracle libraries, when Campaign 

11.1.00.listener was installed on AIX the Oracle libora4d.

HMA-267288 Unable to use apostrphe in text string in derived field or user varaiable.

HMA-285603 It took about 45 seconds when tried to open an offer for editing and 

eventually for saving ('Save Changes'), each time was taking about 45 

seconds.

HMA-298004 An error occurred on process parameters tab of any process box.

HMA-298826 Plain text passwords were observed in campaignweb.log, ac_web.log, 

flowchart log when DEBUG logging was enabled.

HMA-293611 An error occurred while running FastUpgrade scripts in the execution of 

database upgrade task.

HMA-290905 When fields were mapped to a mapped table in Snapshot process box, 

not all fields displayed in the Snapshot process box.

HMA-295972 Target Cell Spreadsheets (TCS) page did not render correctly, if cell 

contained drop down type Custom cell attribute.

HMA-302445 Campaign listener crashed on activeSession.udb.

HMA-301014 Flowchart failed with 701 error with .ses file went missing. Also flow

charts failed with 11116 error.

HMA-302437 Partition1 folder was missing and converted into file causing system 

unusuable.

HMA-291021 Multi-thread UBX ETL hot fix in 11.0.1 caused out of memory.

HMA-300054 Newly Schedule flowchart on trigger failed platform scheduler utili

ty-Multiple users.

HMA-296400 Save and run process function broke when upstream processe did not 

run.
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HMA-304849 Reflected Cross-Site Scripting || Security vulnerabilities reported by 

client.

HMA-299050 Cell Code did not not generate automatically for the last cell when us

ing four and more cells in Segment.

HMA-288426 Disabled medium strength SSL ciphers supported by Optimize.

HMA-302467 Clustered listeners allowed same flowchart to be executed at same 

time on different listeners under certain scenario.

HMA-282757 Users were unable to view logs in the UI for the session flowcharts 

which were migrated from 8.6.x.

HMA-282629 Could not use year more than "2038" in date field of Platform sched

uler.

Known issues in Unica Campaign  12.0
Unica Campaign  12.0 includes the following known issues.

Table  6.

ID Known issues

306157 Platform Scheduled flowcharts are not executed after upgrade. To over

come this, execute Quartz Job update tool. After Campaign or Unica 

Platform upgrade installer execution quartzjobtool.sh / bat utility must 

be executed. This utility requires to be executed to update the Quartz 

Jobs (existing schedules) in the Unica application. Perform the follow

ing steps to execute the utility:

1. Navigate to PLATFORM_HOME/tools/bin

2. Run quartzjobtool.sh /bat. This script execution enables the exist

ing schedules to be compatible with v12.0 Unica applications.
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Table  6.  (continued)

ID Known issues

306383 UBX RegisterEndPoint utility execution is failing with ClassNotFound

Exception. To overcome this, copy below jar files from CAMPAING_

HOME/tools/lib directory into CAMPAIGN_HOME/tools/UBXTools/lib di

rectory.

• byte-buddy-1.9.11.jar

• classmate-1.3.4.jar

• hibernate-jpa-2.1-api-1.0.2.jar

• javax.persistence-api-2.2.jar

• jboss-logging-3.3.2.Final.jar

After this remove ejb3-persistence.jar and hibernate3.jar from 

CAMPAIGN_HOME\tools\UBXTools\lib.

300159 HTTP Communication error occurs, while saving flowchart if Unica Plat

form and Campaign applications are using the same JNDI.

It is suggested to use separate JNDIs for Platform and Campaign appli

cations.

295574 Deployment of Campaign application in WebSphere application serv

er failed due to java.lang.NoClassDefFoundError: javax.el.ELMan

ager. Users are required to add javax.el-3.0.1-b11.jar  in the WAS 

server lib directory. They can download javax.el-3.0.1-b11.jar  from 

https://mvnrepository.com/artifact/org.glassfish/javax.el/3.0.1-b11.

306075 While installing on MariaDB - aco_extra_indexes<DB>.sql  execution 

completed with error while creating duplicate key for index.. This error 

can be ignored.

306110, 306108 While deploying or starting Campaign application, it throws errors re

lated to module-info.class, and warning related to obsolete hibernate 

namespace. These can be ignored.

https://mvnrepository.com/artifact/org.glassfish/javax.el/3.0.1-b11
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Table  6.  (continued)

ID Known issues

304803 Getting "jcc][t4][10217][10310][4.14.111] Connection read-only mode is 

not enforceable after the connection has been established." warnings in 

WebSphere console log. No impact on application side. These can be ig

nored.

306095 Production documentation links on Campaign installer are broken. See 

the documentation available along with product installers.

306229 Create flowchart API using REST is failing with error. This will be avail

able in upcoming fix packs. Please get in touch with support for quick 

fix.

303532 With MariaDB as system database Optimize, Maillist or Calllist process 

box execution fail with error 10646. You must enable In DB Optimization 

in flowchart advance settings to resolve this error.

13460 When the Export to File  option is unchecked on the Fulfillment tab of the 

Mail List process, the Summary File  option is enabled but should not be.

175825 When defaultBehaviorWhenOutputToFile  is set to Create New File, it 

works only when you select a new output (export) file for the first time. 

If you try to change the existing output file and select a new output file, 

then the option Append to Existing Data  gets selected by default.

It can be changed manually to Create New File.

APAR 198495, 

PO05293, 

198494

For a custom macro, if a user account has assigned as Not Granted 

permission for a stored object (Custom Macros, Flowchart Templates, 

Stored Derived Fields, etc.), the custom macro can be used to edit, 

delete, add, move all stored objects regardless of permissions.

204347 LARGE_DATA: Browser Crash - Mail List process box with 700 segments 

- Save with 512 offers to each segment.
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Table  6.  (continued)

ID Known issues

211253 File-based input with multiple columns containing date in different for

mat does not read the date correctly.

212890 Boolean type column on Amazon Redshift is recognized as 'Test' field 

type in table mapping.

220474 When the column name of the source table contains Non-ASCII charac

ters and is long (probably longer than 10 x 3bytes characters in UTF8), 

the Snapshot process does not run because the temp table is not creat

ed.

220705 Profiling count for Dimension table fields is incorrect and profiling per

centage is displayed as 100% even if profiling is in progress.

APAR 222047, 

PO06172, 

222049

Unica Campaign extract process does not write to DB2 database when 

flowchart is configured with two extract processes and the second ex

tract process contains a derived field that uses French accented charac

ters in the name of the derived field.

APAR 225568, 

PO06304, 

225572

temptablepostexecutionsql  is not run when selecting coremetrics 

segment.

230340 Inconsistent behavior for the Mail list process is observed when the da

ta filter is assigned to Effective date  on the Parameters tab in a new 

Mail list process when compared to an edited existing Mail list process. 

The Mail list process does not output a datetime derived field in the out

put log file. Changing the effective date parameter values might cause 

execution failure of the Mail list.

230606 In a flowchart where fields are extracted and used in a Mail list process, 

the fields under Extract Node  on the Personalization tab of the Mail list 

process are different before and after running the process.
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Table  6.  (continued)

ID Known issues

231859 While using the Chrome browser, it takes around 20 seconds to respond 

while loading the Personalization tab of the Mail list process if it con

tains large number of treatments and offers assigned. For example, a 

Mail list process with 250 cells, each cells with multiple offers, each of

fer having multiple attributes.

232502 A Mail list performance issue occurs when the user changes the input in 

any way and there is a delay when initially switching tabs. After the user 

changes the input and switches to the Treatment or Process tab for the 

first time, there is a delay of around 10-15 seconds depending on the 

number of inputs selected. After this initial delay, there is no delay until 

the input is changed.

232835 The Campaign application performance is affected and sometimes an 

exception error message is displayed on the Campaign pages when the 

application is used for a longer time (some days) with continuous us

age. You must restart your Campaign web application and Campaign 

Listeners

238789 While using the Chrome browser, when a user opens a Mail list with 600 

cells having multiple offers assigned to each cell, the application stops 

responding. While using the Internet Explorer 11 browser, nothing is dis

played in the Mail list process box.

239142 When the Audience process fails because of an incorrect Count filter 

expression, and the user removes the filter expression, adds a Condi

tion, and runs the Audience process again, the process fails. The Condi

tion is not considered and instead the previous Count filter expression 

is used resulting in the failure. To run the Audience process successful

ly, you must re-open the Audience process configuration window, click 

the Condition, Save and Close. The Audience process now considers the 

Condition and runs successfully.
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Table  6.  (continued)

ID Known issues

APAR 243895, 

PO06966, 

243897

A space character is converted to ''  while profiling.

PMR 223848, 

245664

Irrelevant flowcharts turned up in a Campaign when different users ac

cess different flowcharts at the same time, the wrong flowchart seems 

to be displayed.

248007 Hive Performance: PRE -Single Insert statements executed for loading 

data in temp tables (extract) when used with Hive takes 19 minutes for 

2000 records.

PMR 269280, 

269765

Truncate does not function for the DB2 database. The DeleteAsTrun

cate  property specifies whether, when an output process is configured 

to REPLACE TABLE, Campaign uses TRUNCATE TABLE  or deletes from 

the table. When the value is TRUE, Campaign runs a TRUNCATE TABLE 

from the table. When the value is FALSE, Campaign runs a DELETE FROM 

from the table. The default value depends on the database type, with a 

large number of clients moving from Oracle to DB2 the difference in per

formance is extremely noticeable. The comparison in performance in 

Snapshots and Mail lists for customers leaving Oracle to DB2 is drastic.

269785 For the Chrome and Safari browsers, when the locale is set as Japan

ese, the labels overlap the buttons in the Save template window.

270528 Use  and Profile  buttons remains enabled for the Select process when 

the user selects some table fields and then applies the search filter in 

the Select process such that it does not return any matching table.

270814 Users cannot select values from the On a trigger drop down by using the 

mouse on the Scheduler page.
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Table  6.  (continued)

ID Known issues

271642 A "Please wait....."  message is displayed multiple times in console 

mode installation while upgrading from version 10.1 and also for new 

Installation

271676 The Extract table on the DB2 and Oracle databases is not deleted when 

In-DB optimization is unchecked.

272253 The Campaign application performance is affected when a user opens 

the Table mapping window and more than 500 tables are mapped.

2968 Hot keys are not implemented on most of the windows. In the Dojo im

plementation it is not possible to use keyboard shortcuts to activate cer

tain functions. Instead the user must click buttons.

PMR 266519, 

75262

Clicking Return to previous page  distorts the user interface in some 

cases. Use the links within the products to navigate, rather than the 

browser controls.

N/A When Unica Campaign is deployed in an application server cluster envi

ronment with 80 port, the Campaign navigation URL should not contain 

this port number. For example: http://<host>.<domain>:80/Campaign 

should be changed to http://<host>.<domain>/Campaign. Change 

the value of the serverURL  property under Campaign|navigation on the 

Settings > Configuration  page.

N/A Mail List process box gets unconfigured with error "31606: History 

table are changed"  on Flowchart run.

1. There is no issue if the history tables are mapped prior to building 

a flowchart and adding a Mail List process.

2. If you do not follow step 1, you can still map the history tables af

ter the error appears. If you edit the flowchart and configure the 

process box, the process will run.
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Table  6.  (continued)

ID Known issues

N/A After migrating non-ASCII data to Campaign, in some cases you cannot 

open Campaign flowcharts on the target system. Session flowcharts 

open successfully. To work around this issue, remigrate the campaigns 

in overwrite mode. You can then open the flowcharts.

TT 062333 Information related to associated products does not appear in offer on 

Marketing Operations. When an offer created in Campaign with prod

ucts associated with it is imported in Marketing Operations, information 

about the associated products is not available in Marketing Operations.

270655 Table Mapping : Table name containing @ is supported while mapping 

a table, special characters like @ are should not be supported in Table 

names. Since Table name containing @ is supported since some time, 

this functioning is not updated now.

283637 When user has one maillist PB configured in the flowchart and he adds 

another maillist PB in the same flowchart, it is observed that All the val

ues from already configured in treatment tab, Parameters tab, Personal

isation tab of new Maillist PB appear automatically in any new dragged 

maillist PB.

281389 While running Campaign in the Upgrade mode, the installer should read 

the installation properties files from the previous version response files 

as we had that response available at the install location from the pre

vious installation. However, it does not read the installation properties 

files from the earlier version response files.

280623 In Sample PB if we specify '3' in "# of Samples/Output Cells" field and 

Configure [sample1] with 3 samples having sample sizes as 50%, 50% 

and "All remaining records" respectively based on "Random Sample 

method" then after running Flowchart if we reopen the Sample PB 
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Table  6.  (continued)

ID Known issues

"Process run results will be lost. Continue?" message is displayed in 

sample PB when remaining All check boxed is check.

283101 CHROME: "Unable to notify roles/permission changes to Campaign, e

Message OD may be out of sync". On clicking save changes for the Se

curity Policy displays the following pop-up, this happens just first time 

after user logs in and changes anything in the policy and clicks save 

changes. Also, this is reproducible just on CHROME. Tested on Chrome 

V64 and V65.

282844 Campaign Offer doesn’t sort on 'Channel' & 'Eff./Exp.Dates'. After click

ing on every column the offers below it should be sorted in ascending 

order. If you click on the same column the second time, the offers be

neath it should be sorted in the descending order.

283695 Segment process box execution failed with extract enabled to User 

database for the IMPALA user DB. This error does not reproduce when 

extracting to Unica Campaign server.

284436 Platform.war and campaign.war in ear file deployment will not work in 

Weblogic 12.2.1, work around is to deploy campaign.war and unica.war 

separately

288228 If the date field uploaded to IMC side is not in mm/dd/yyyy format, the 

email process box fails to execute. This data format is required by IMC 

Importlist API. It works accurately if DELIM_M_D_YYYY(mm/dd/yyyy) 

format is used for date while uploading to IMC using importlist API.

289135 TOMCAT : Occasionally Unica Platform or Campaign does not gets 

started after deploying in tomcat application server. Workaround : 

delete Campaign and Platform directory available inside Tomcat we

bapps directory and delete the content of work directory from the path 

where Tomcat is installed.
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Table  6.  (continued)

ID Known issues

304945 Refresh command does not refresh the master listener priority or 

weight, if you need to make changes in priority or weight you require to 

take a downtime and restart the application.

Known issues in Optimize 12.0

Issue Issue ID Description

Scores entered manually in the score 

matrix are not considered while opti

mizing the contact list.

Defect 194109 Scores entered manually 

should be considered for cal

culation in the Customer Ca

pacity rule. However, while 

applying the Customer Ca

pacity rule, scores in the PCT 

are considered, and all cus

tomer records are removed 

in the optimized list.

Campaign Optimize summary report is 

incorrect.

Defect 176368 If offer versions are used in 

a rule, the report that shows 

pre-optimization versus post-

optimization counts will al

ways report the pre-opti

mization count of records 

as 1. The post-optimization 

counts will be correct.

After upgrading Campaign to 9.1, Opti

mize listener can no longer be stopped 

via ACOServer.sh.

Defect 81245 Users must upgrade Unica 

Campaign  and Unica Opti

mize  together. If they can

not, they will need to stop the 



Unica Campaign V12.0 Release Notes  | 1 - Release Notes  | 28

Issue Issue ID Description

Unica Optimize  listener man

ually through the task man

ager/kill command.

Error messages for the ACOOptAdmin 

utility do not display according to non-

English locales.

DEF051284 When you run the ACOOpt

Admin command line utility 

in a locale other than English, 

error messages do not dis

play according to the spec

ified locale. The error mes

sages display only in English.

unprocessables_sessionid.csv 

might contain some customers who re

ceive offers.

DEF054841 In some scenarios, a few of 

the customers who get of

fers might be present in the 

unprocessables_ses

sionid.csv  file.

Incorrect optimization result with Cus

tom Capacity rule in specific circum

stances.

DEF058362 A customer that satisfies the 

following criteria might re

ceive fewer offers than want

ed:

• The customer has an 

even number of pro

posed transactions.

• Each of these trans

actions has the same 

score.

• This score is a low val

ue.

Some labels display incorrectly in 

Japanese, Chinese, and Korean.

DEF059595 Some translated labels are 

displaying incorrectly. For 



Unica Campaign V12.0 Release Notes  | 1 - Release Notes  | 29

Issue Issue ID Description

example, when you edit the 

score matrix manually, the 

vertical label on the right 

side of the table displays 

upside down. Also, for opti

mization rules that contain 

customers in the segment, 

the segment  label displays 

on two lines.

Offer filtering summary report displays 

an incorrect count of Proposed Con

tacts that are removed by each Custom 

Capacity rule.

DEF059805 The Offer Summary Report 

displays incorrect counts in 

the "Removed By This Rule" 

column for Custom Capac

ity rules if the participating 

Flowchart for this Unica Op

timize  session contains mul

tiple contact dates and mul

tiple offers that are made to 

each customer on different 

channels.

Issues with offer version query builder. DEF060676 There are several minor is

sues with the offer version 

query builder:

• For custom attribut

es with the Form Ele

ment Type of Select 

Box, the offer version 

query builder does not 

use the select box. You 
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must enter the value 

manually.

• When the group level is 

removed, the subgroup 

conditions are added 

to the parent condition, 

and vice versa.

• All arithmetic opera

tors are displayed for a 

string variable, but on

ly equal and not equal 

apply.

• Defined length valida

tions for attributes are 

not verified upon input 

for conditions.

Offer version rules that contain dates 

do not provide expected optimization 

results.

DEF061554 If you create an offer version 

condition that includes a 

date, such as the offer para

meter "valid end date" equals 

"12/31/2011", the rule con

taining offer version condi

tion might not be satisfied; 

however, the rest of the rules 

will work as expected.

Rule exceptions that span calendar 

years give incorrect results.

DEF061639 If you create a rule excep

tion to a Min/Max # Offers 

capacity rule that spans 

calendar years, such as 

07/01/2011 to 06/30/2012, 
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the rule containing rule ex

ception condition will not be 

satisfied; however, the rest 

of the rules will work as ex

pected.

<unica_svradm> refresh command 

does not reflect the change.

HMA-304945 On a running environment, 

after changing the master 

listener priority, <unica_

svradm> refresh command 

does not reflect the change.

<unica_svradm> refresh command 

does not delete the node from cluster.

HMA-305764 If you delete a listener node 

from existing cluster, <uni

ca_svradm> refresh com

mand does not delete the 

node from cluster. Execution 

requests are still observed 

going to the deleted node. 

Restarting the listener solves 

this issue. Will be fixed in up

coming fixpack.

Users are still able to manually inter

fere in the running flowchart when 

flowchart execution is in progress 

through SVRADMIN utility.

HMA-306037 When flowchart execution is 

in progress through SVRAD

MIN utility or using sched

uler, user is still able to man

ually interfere in the running 

flowchart. Will be fixed in up

coming fixpack.

New Optimize process box UI like Cre

ate Optimize session / Edit Session / 

HMA-306473 New Optimize process box 

UI like Create Optimize ses
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Copy Session, etc. is seen in English 

and not getting translated to other lo

cales.

sion / Edit Session / Copy 

Session etc. is seen in Eng

lish and not getting translat

ed to other locales. Will be 

fixed in upcoming fixpack.

Known limitations in Unica Campaign  12.0
Unica Campaign  12.0 includes the following known limitations.

Table  7. Unica Campaign  known limitations

ID Known limitation

304128 Platform login method or users authentication from third party directo

ry services is not supported with Campaign or Optimize APIs. Users re

quire to use the Unica Platform user to use with APIs.

305130 The flowchart template is not imported, if it contains data source name 

more than 256 character length. Save the flowchart template again by 

changing the datasource name with less than 256 chars.

305764 For any reason, if users delete the Campaign listener node configuration 

from listener cluster configuration in Unica Platform, while the applica

tion is up and running then users connected to this listener node are not 

redirected to another listener. You must restart the Campaign web ap

plication. If you require to delete the listener node, take a downtime and 

restart Campaign web and listener components.

17202 Error 19024: Cannot delete segment folder if the segment was deleted 

from the folder. A segment that is deleted from a folder remains as an 

inactive segment in the folder. Folders with inactive segments cannot 

be deleted. This is working as intended.
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Table  7. Unica Campaign  known limitations  (continued)

ID Known limitation

185854 Big data: Campaign integration with Hadoop-based Hive big data as a 

user data source is not tested on MS Windows operating system.

190621 Big data: Campaign with Hive big data as a user database does not sup

port user table mapping with Base and Dimension levels up to the fourth 

level hierarchy. If you map a Base record table with four levels of di

mension tables in a Select process box, then build a query based on 

the fourth level Dimension table, the query fails with Error 11528. This 

issue should not affect big data users because multiple dimensions 

should not be needed. By definition, a big data source has a large table 

of records split across Hadoop nodes (such as HDFS).

194095 For Redshift database, the error message "Unsupported type time

stamps with time zone" is displayed when exporting data from a Snap

shot process box. Timestamp with timezone is an unsupported Postgre

SQL data type on Amazon AWS.

195581 While running a Campaign flowchart, if listener crashes or is stopped, 

user is not able to access the running flowchart from the UI. Requests 

are being served by another node of the cluster but while accessing the 

flowchart, a pop-up message says "listener failover occurred..." It may 

be necessary to restart the master listener.

232032 User can start only one IBM Campaign listener on one server (machine) 

in case of Listener clustering.

PMR 243195, 

244148

When a column that has the Greek Letters A and B is profiled in Cam

paign, the system returns only A along with the count of all the records. 

After the fix, some of the non-English characters, which differ only in 

case (like é and É in French), are counted as two different values in pro

filing. English language characters are not counted as case sensitive.
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ID Known limitation

244482 Deep search lists all the Campaigns that are created through Market

ing Operations projects when Campaign - Marketing Operations integra

tion is on. Campaigns that are created through Marketing Operations 

projects when Marketing Operations - Campaign integration is enabled) 

are not listed on Campaign list page and are only available on the Mar

keting Operations project listing page. Users who do not have the per

mission to access Marketing Operations are able to access campaigns 

which are created through Marketing Operations projects through Deep 

search results.

248943 If the user profile database is changed (change in the table column val

ues of audience record) for fields other than sync fields and the user 

runs the Email process again, a negative count is returned for the DU

PLICATES parameter from Engage in the Campaign flowchart log.

N/A Big data: To perform the UPDATE operation on any process boxes in a 

flowchart, ensure that your HIVE tables are configured as transactional 

tables such that they support the ACID property. This is a key feature in

troduced in HIVE version 0.14.

N/A IBM Interact when configured with IBM WebSphere Application Serv

er: You must configure IBM WebSphere JVM to use JDK 1.7. When IBM 

WebSphere Application Server 8.5.5.x is configured with JDK 1.7 and 

HTTPS communication, you must use IBM JAVA SDK version 7.0.8.10 

or higher.

N/A Using multiple SQL statements for raw SQL queries is not currently sup

ported on big data user datasources. For related information, search the 

IBM Knowledge Center for Hive query language conformance.

N/A Dialog behavior: In certain cases, it is necessary to click twice in order 

to activate a field or change a field value.



Unica Campaign V12.0 Release Notes  | 1 - Release Notes  | 35
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ID Known limitation

N/A The monitorEnabledForEmessage  configuration property in Cam

paign|monitoring  is not currently used.

N/A Relevant products limitation: When offer management is performed 

from IBM Marketing Operations, the "relevant products" functionality, 

which relates product IDs to offers, is not available.

N/A Blank or incorrect results from derived fields in a Mail List process. This 

can occur in a process box that uses a derived field that calls a Generat

ed field (UCGF) that changes value.

Do not use a UCGF in a Mail List derived field if the UCGF is not con

stant. Also, from the Parameters tab, do not create a derived field to call 

a UCGF to populate offer attributes.

N/A Profiling a Campaign Generated Field (UCGF) does not yield correct re

sults. Some UCGFs have a value according to the cell or the offer being 

processed. For cell-related UCGFs, only the value associated with the 

first cell appears during profiling.

N/A The default value for a custom cell attribute does not appear when you 

open the target cell spreadsheet. Although the default value is not ini

tially displayed, it will be used. The value can be displayed or changed 

by clicking or opening and editing the custom cell attribute in the target 

cell spreadsheet.

N/A The UA_UsrResponseType.Name  field cannot contain a left parenthesis 

followed by a single quote.

N/A Use unique TempTablePrefix  for each data source when mapping multi

ple data sources to same physical database.

If you mapped multiple data sources in Unica Campaign  to the same 

physical database, and you use the same TempTablePrefix  for more 

than one of the data sources, when you use the cleanup utility to delete 
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ID Known limitation

orphaned temp tables, it may falsely identify temp tables as orphaned, 

when they are in fact legitimate temp tables defined from a different 

Unica Campaign  data source.

Any deleted temp tables will automatically be recreated when you rerun 

affected flowcharts, but as a best practice, use a unique TempTablePre

fix  for each data source when mapping multiple data sources to the 

same physical database.

If the data sources defined in Unica Campaign  map to different 

schemas in the database, another solution is to ensure that the data

base user who runs the cleanup utility does not have privileges to drop 

tables in other schemas in the same database.

161323 The error "Login failed. Error 10553" can occur if you try to log in to the 

Campaign utilities when the Unica Platform | Security | login  method is 

set to Windows integrated login  or Web access control. To avoid this is

sue, change the login type to LDAP  or Platform  prior to using the Cam

paign utilities..

176377 DB2 10.5 BLU for user DB: No indexing requirement for temp tables 

in Unica Campaign  datasource. DB2 10.5 (with BLU feature ON) does 

not require indexing in Unica Campaign. Unica Campaign  has certain 

properties for datasources, such as TempTablePreTruncateRunScript, 

TempTablePostExecutionSQL, and PostTempTableCreateRunScript, 

where you can provide SQL or scripts to create indexes on user data

base tables. If you are using DB2 10.5 as a customer database, with the 

BLU feature ON, you do not need to configure any of these temp table 

properties.

201,968,200,241 If two process boxes are moved very close together in a flowchart, the 

direction of the connection arrow changes. This limitation affects the vi

sual representation of the arrow. The process data flow is not affected. 
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ID Known limitation

The workaround is to move the process boxes farther apart so the ar

rowhead changes back to the correct direction.

211293 In  Unica Campaign, the built-in macro Current_Date() results in an er

ror when executed against a Hive 1.2 based Big Data instance. The Hive 

ODBC driver does not support the CURRENT_DATE macro to obtain in

terval values. For example, executing the following query results in a 

Hive error:

SELECT DISTINCT customerid FROM Customer_date WHERE ((Cus

tomer_date.my_date_mmdyyyy - CURRENT_DATE()) >= 7)

Error: Hive 2 Internal error: unsupported conversion from type: interval_

day_time

Workaround: To use the CURRENT_DATE function in a RAW SQL query 

on Hive with Hortonworks, execute SQL in the following format:

SELECT DISTINCT customerid FROM Customer_date WHERE (current_

date() - my_date_mmddyyyy ) = interval '0 0:0:0' day to second

213088 If Campaign is installed in a secured environment but IBM Cognos is in 

an unsecured environment, Cognos reports will not display when you 

use Microsoft Internet Explorer 11. Workaround: If IBM Campaign is 

configured with HTTPS, also configure IBM Cognos on HTTPS.

217488 IBM can support the Database Loader for Redshift until the moment 

Campaign triggers the Loader Script. Any problems in execution of the 

loader script are not supported by IBM.

223716 Authentication Bypass Using HTTP Verb Tampering

Instead of applying theHttpVerbFilter.class patch, you can use the fol

lowing workaround to ensure application security.

Complete the following steps to update web.xml.
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Table  7. Unica Campaign  known limitations  (continued)

ID Known limitation

1. Update the web app tag and set the xsd version to 3.0.

<web-app 

 xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance

" 

  xmlns="http://java.sun.com/xml/ns/javaee"

 

 xsi:schemaLocation="http://java.sun.com/xml/ns/javae

e 

  http://java.sun.com/xml/ns/javaee/web-app_3_0.xsd"

  id="Platform" version="3.0" 

 metadata-complete="true">

2. Add the following in web.xml.

<!--[start] WhiteList Http Verbs -->

<security-constraint>

  <web-resource-collection>

 

 <web-resource-name>Unica_WhiteList_Http_Verbs</web-r

esource-name>

  <url-pattern>/*</url-pattern>

  <http-method-omission>GET</http-method-omission>

  <http-method-omission>POST</http-method-omission>

  <http-method-omission>TRACE</http-method-omission>

  <http-method-omission>PUT</http-method-omission>

  <http-method-omission>DELETE</http-method-omission>

  <http-method-omission>PATCH</http-method-omission>

 

 <http-method-omission>OPTIONS</http-method-omission>

  <http-method-omission>HEAD</http-method-omission>
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ID Known limitation

  </web-resource-collection>

  <auth-constraint/>

</security-constraint>

<!--[end] WhiteList Http Verbs -->

283805 IBM Websphere Application Server 8.5.5 Fix Pack 12 requires IFPI85892 

to run HCL Unica application.

283544 On Oracle 12.2 database server following parameters needs to be 

added in sqlnet.ora file located under ORACLE_HOME/network/ad

min/SQLNET.ALLOWED_LOGON_VERSION_SERVER

User will need to consult with DBA to provide appropriate value to 

this parameter. Please refer this link for details: https://docs.oracle

.com/database/121/NETRF/sqlnet.htm#NETRF2016

N/A Campaign Integration with Watson Marketing Assistant is not support

ed on Internet Explorer.

286705 Two events get generated on the Campaign history tab when user paus

es the Campaign flowchart from Operational monitoring.

287100 History tab data remains in UA_History table even after deleting the 

Campaign

290172 Cutting off right contents from Relevant offers window.

Workaround: The size of text, apps and other items - under Display 

should be set to 100%.

https://docs.oracle.com/database/121/NETRF/sqlnet.htm#NETRF2016
https://docs.oracle.com/database/121/NETRF/sqlnet.htm#NETRF2016
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Known limitations in Unica Optimize 12.0
Issue Number Description

Strings in the production or 

test pop-up window are not 

translated.

Defect 

176920

In the case of a non-English setup, the 

strings in the production or test pop-up win

dow are not translated.

The MailList process fails 

with the following database 

error: ORA-00999: INVALID 

VIEW NAME.

Defect 

170951

Change the value of UseTempTablePool 

from TRUE  to FALSE  in UA_SYSTEM_TABLES. 

The MailList run will end successfully.

Unica Optimize  does not 

terminate the unica_acsvr 

process that is opened dur

ing a run.

Defect 

164875

In case of a schedule run of a Unica Opti

mize  session by using the Unica Platform 

Scheduler, you observe multiple unica_

acsvr  login processes. These processes 

might terminate automatically after some 

time.

A DB2 database user change 

of system tables causes a 

Unica Optimize  session to 

fail when the administrator 

has an index with the same 

name.

Defect 

155876

To avoid having a session fail, the DB2 data

base administrator should remove indexes.

In a Unica Optimize  report, 

offers by type and segment 

do not get printed as de

sired.

Defect 

102889

The following issues were noticed while 

printing the offers by type and segment in a 

Unica Optimize  report.
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Issue Number Description

1. The preview window does not scroll, 

unless it is resized.

2. While printing it does not print every

thing, but only what fits in A4 size. 

Printing options do not seem to make 

any difference.

Negative scores cause inac

curate rules crediting.

DEF041400 If you use negative scores, rule crediting in 

the Offer Filtering Summary report might not 

be accurate.

Offers with negative scores are given to 

meet minimum requirements only.

Cells that are linked to TCS 

with offer assignments 

do not appear in Optimize 

process.

DEF061355 If the Optimize process is connected to one 

or more cells and the upstream cells are lat

er linked to top-down cells defined in the 

Target Cell Spreadsheet process (TCS), 

the offers that are assigned in the TCS do 

not automatically appear in the Optimize 

process. Link to any top-down cells in the 

TCS before you connect those cells to an 

Optimize process. Otherwise, you must ei

ther manually assign the same offers within 

the Optimize process, or delete the Optimize 

process and re-create it.

Running the ACOOptAdmin 

utility with one-way SSL re

quires more setup.

DEF046832 You cannot use the ACOOptAdmin  utility 

with one-way SSL until you register a se

curity certificate, specify a host name and 

domain, and configure SSL_Options in the 

ACOOptAdmin.bat  file.
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Issue Number Description

Unable to run the session in 

first attempt when unica_a

cosvr process stopped.

DEF055010 If you use the kill  command to stop unica_

acosvr, the next time you attempt to run a 

Unica Optimize  session, it might fail with the 

following error: An unknown communication 

failure has occurred with the  Opti

mize server process.

Workaround - Run the Unica Optimize  ses

sion again to complete it successfully.


	Unica Campaign V12.0 Release Notes
	Contents
	Chapter 1. Release Notes
	Unica Campaign 12.0 system requirements and compatibility
	Where to find complete system requirement and compatibility information
	Prerequisites for using Unica Campaign
	Unica Campaign documentation roadmap
	


	New features and changes in version 12.0
	Upgrade Paths
	Fast Upgrade
	New third party softwares supported
	Campaign and Optimize – replace GSKIT with OpenSSL
	Campaign flowchart execution Email Notifications
	Campaign REST API Support for Campaign objects like Campaigns, Session, Flowcharts, Process boxes, and swagger documentation
	Campaign and Optimize seamless integration
	Centralized Offer Management
	Out of the Box Reports with BIRT reporting tool

	Fixed defects in Unica Campaign and Optimize 12.0
	Known issues in Unica Campaign 12.0
	Known issues in Optimize 12.0
	Known limitations in Unica Campaign 12.0
	Known limitations in Unica Optimize 12.0


